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1 Úvod
Nikdo jiný než člověk nemění krajinu kolem sebe tak výrazně. Již po staletí se člověk snaží měnit krajinu kolem sebe tak, aby co nejlépe vyhovovala jeho potřebám. Ne vždy jsou však ony změny tím správným krokem. 20. století bylo navíc, pro území současné České republiky, plné změn. Ovlivnila 2. světová válka a následné odsunutí sudetských Němců vývoj krajinné struktury? Jakým způsobem se vyvíjela krajina od poloviny 20. století? Tato bakalářská práce by Vám alespoň z části mohla odpovědět na tyto otázky.
Práce se zabývá změnami v krajinné struktuře v obci Mříčná a Stružinec po odsunu sudetských Němců až po současnost. Tyto dvě obce v severních Čechách byly vybrány zcela záměrně. K obci Mříčná mám osobní vztah a zároveň je obcí v okrese Semily, která zaznamenala největší úbytek počtu obyvatel po druhé světové válce na Semilsku. Naopak obec Stružinec, která je svou rozlohou s obcí Mříčná srovnatelná, zaznamenala úbytek obyvatel zcela minimálně. 
V první části práce je stanoven cíl práce, metodika a postup řešení problematiky. V druhé části je blíže představeno zájmové území z přírodního či socioekonomického hlediska. Následující kapitoly (5 a 6) se věnují teoretickému rozboru problematiky. V kapitolách 7 a 8 jsou již představeny jednotlivé výsledky studie. Následuje závěr a knižní a internetové zdroje.
2 Cíle práce
Cílem této práce je zhodnotit změny ve využití krajiny v obcích Mříčná a Stružinec po roce 1945 a zhodnotit, zda-li se struktura krajin vyvíjela v těchto obcích odlišněji či nikoliv. Práce se bude zabývat výhradně změnami v horizontální prostorové struktuře krajiny. 
Pro vytvoření této práce budou využity grafické podklady. A sice letecké měřické snímky (LMS) za roky 1947, 1957 (pouze pro obec Mříčná, pro obec Stružinec rok 1958), 1977, 1989 a ortofoto mapy za roky 2007 a 2018. 
3 Materiály a Metodika práce
3.1 Popis dat 

Pro studium změn v kulturní krajině můžeme využít několika typů materiálů. Těmito materiály mohou být jednak mapové podklady, letecké a družicové snímky, ale také nejrůznější historické písemné zdroje, či obrazy a pohlednice (LIPSKÝ, Z., 2000).

Pro sledování změn ve využití krajiny byly v této bakalářské práci využity letecké měřické snímky (LMS) a ortofoto České republiky. 

3.1.1 Letecké měřické snímky (LMS)

Základním pilířem pro sledování změn ve využití krajiny ve dvou obcích na Semilsku, Mříčné a Stružinci, posloužily letecké měřické snímky (LMS). Snímky jsou archivované v Archivu leteckých měřických snímků Vojenského geografického a hydrometeorologického úřadu (VGHMÚř) v Dobrušce. 
Jelikož snímkování neprobíhalo vždy v obou obcích zároveň (myšleno v horizontu jednoho kalendářního roku) a taktéž ani ve stejných intervalech, byly nakonec vybrány snímky za tyto roky: pro obec Mříčná snímky za roky 1947, 1957, 1977 a 1989; pro obec Stružinec: 1947, 1958, 1977 a 1989. 
Letecké snímky nám byly zaslány z VGHMÚř a byly využity jen pro potřeby této bakalářské práce.

Letecké měřické snímky jsou ovšem opatřeny podstatnou mírou zkreslení. Nelze je tedy použít k přímému měření polohových vztahů mezi zobrazenými geografickými objekty. Je proto zcela nevyhnutelné jednotlivé snímky, kterých byla celá řada a pro jednotlivé obce za jednotlivý rok i několik, nejprve georeferencovat. 
3.1.2 Ortofoto ČR
Ortofoto České republiky (ČR) představuje periodicky aktualizovanou sadu barevných ortofot v rozměrech a kladu mapových listů Státní mapy 1:5 000 (2x2,5 km). Na ortofotu je fotografický obraz zemského povrchu překreslený tak, aby byly odstraněny posuny obrazu vznikající při pořízení leteckého měřického snímku. Ortofota jsou barevně vyrovnaná, zdánlivě bezešvá (švy jsou vedeny po přirozených liniích) (URL1).
Tvorbu ortofot ČR zajišťuje Zeměměřický úřad již dlouhodobě ve spolupráci s Vojenským geografickým a hydrometeorologickým úřadem (VGHMÚř) na základě dohody ČÚZK s Ministerstvem zemědělství (MZe) a Ministerstvem obrany (MO) (URL1).
Pro tuto práci byly vybrané orotofoto mapy vztahující se k letům 2007 a 2018. 

3.2 GIS

Zkratka GIS je odvozena z anglického Geographic Information System, do češtiny překládaného jako geoinformační systém nebo jako geografický informační systém (TOLLINGEROVÁ, 1996).
Pro potřeby této práce uvedu alespoň jednu definici, podle ESRI (2019), což je společnost zabývající se vývojem softwaru určeného pro práci s geografickými informačními systémy: „GIS je organizovaný soubor počítačového hardware, software a geografických údajů navržený pro efektivní získávání, ukládání, upravování, obhospodařování, analyzování a zobrazování všech forem geografických informací.“
3.3 ArcGIS – ESRI
Společnost ESRI vyvinula software, jenž nese název ArcGIS Desktop. Díky tomuto softwaru můžeme zpracovat LMS a vytvořit tak rekonstrukci využití krajiny v dřívějších letech. Tento software nám umožňuje zpracovávat prostorově orientovaná data. Obecně řečeno jde o digitální zpracování map a informací vztahujících se k mapovaným prvkům. Obsahem je prostorová informace (vrstva) a tabulka (FORMAN, R. T. T., GODRON, M, 1993).
Datová struktura GIS:

· prostorová rastrová data (např. Ortofoto mapy, katastrální rastrové mapy),
· prostorová vektorová data (např. Územní plán, inženýrské sítě),
· digitální model terénu (např. Výškopis ve formě vrstevnic, profily, 3D modely),
· atributová data (např. databáze, popisky prvků, dokumenty).
(FORMAN, R. T. T., GODRON, M, 1993)

ArcMap je centrální aplikace ArcGIS Deskop, která slouží pro všechny mapově orientované úlohy včetně kartografie, prostorových analýz a editace dat. ArcMap je aplikace, která poskytuje kompletní funkcionalitu pro tvorbu mapového výstupu (KLIMÁNEK et al., 2008).

3.4 Práce v ArcGIS Desktop

K vypracování podrobného postupu posloužily materiály od GELETIČ, J. a kol. (2013), KLIMÁNEK, M. (2008) a TUČEK, J. (1998).
Po spuštění programu se nám zobrazí první dialogové okno. Zde je třeba zvolit nový (prázdný) projekt a potvrdit kliknutím na ok. Projekt je lepší si hned v této první fázi uložit: Menu (File → Save), zvolíme adresář a pojmenujeme soubor.
Zcela nevyhnutelné je nastavit novému projektu souřadnicový systém. Klikneme pravým tlačítkem myši na vrstvy (Layers) v tabulce obsahu projektu (Table of Contents). V zobrazeném menu zvolíme vlastnosti (Properties) a v záložce Coordinate System vybereme zvolený souřadnicový systém. Ten vybereme samozřejmě podle toho pro jakou oblast budeme mapy vytvářet. Pro různé kouty světa jsou vytvořené různé koordinační systémy. Pro naši práci poslouží souřadnicový systém S-JTSK (Select coordinate system: Predefined → Projected Coordinate Systems → National Grids → S-JTSK Krovak EastNorth). 
Nyní je třeba nahrát do programu naše mapové podklady. Tady je třeba říci, že v tak velkém počtu sledovaných období, jako je tomu např. u této bakalářské práce, je lepší vytvářet pro jednotlivé roky samostatný projekt. Proto je lepší načíst podklady jen pro jedno sledované období. Výběr dat provedeme následujícím způsobem: File → Add Data. Zde dohledáme naše požadované soubory a potvrdíme výběr. 

V ArcCatalogu můžeme vytvořit soubory shapefile následujících typů:

· point,
· polyline,
· polygon,
· multi point,

Aplikaci ArcCatalog otevřeme v menu Start → Programy → ArcGIS → ArcCatalog, nebo jí můžeme otevřít přímo z ArcMap kliknutím na ikonu v nástrojové liště. V ArcCatalogu klikneme pravým tlačítkem myši na pracovní složku, zvolíme New → Shapefile, v okně Create New Shapefile napíšeme název souboru (zde je lepší pojmenovávat soubory bez diakritiky a bez mezer, které lze nahradit například podtržítkem), vybereme požadovaný typ prvku (např. polygon) a kliknutím na Edit nadefinujeme souřadnicový systém (v našem případě S-JTSK). 
Pro účely této práce se však nabízela snadnější alternativa, která nám později usnadní editaci. Ze souboru vrstev ArcCR 500, který je volně dostupný si nahrajeme do projektu vrstvu „ObcePolygony“. Pravým tlačítkem klikneme na vrstvu polygonů obcí v Table Of Contents (většinou se nachází v levé části projektu, případně ji zapneme přes ikonku v panelu nástrojů) a levým tlačítkem klikneme na Properties. Zde nalezneme záložku Definition Query → Query Builder. Tato funkce nám umožní přesně vybrat části vrstvy, které chceme aby se nám zobrazily v pracovním prostředí. Následně vybereme polygon naší obce: NAZ_OBEC = 'Mříčná' a potvrdíme výběr přes ok. Nyní uložíme námi vybraný polygon obce jako vrstvu shapefile: Properities → Data → Export Data, zde v záložce export vybereme možnost: All features In View Extent, vybereme umístění souboru a potvrdíme. Následně se otevře dialogové okno s tím, zda-li chceme vrstvu nahrát do projektu, potvrdíme.
Poté, co máme vytvořenou vrstvu shapefile, kterou budeme v pozdější fázi editovat a která nám na úplném konci poslouží k interpretaci výsledků, je ještě třeba georeferencovat LMS. LMS nemají přidělený koordinační systém. Jelikož jsou opatřeny notnou dávkou zkreslení, je třeba je transformovat do souřadnicové soustavy. Georeferencování se provádí pomocí tzv. vlícovacích bodů (Control Points), kdy jsou danému pixelu rastru určeny konkrétní souřadnice. 
Nejprve je třeba si zapnout lištu georeferencování: Customize → toolbars → georeferencing. V této liště vybereme vrstvu, kterou máme v plánu georeferencovat a klikneme na Add Control Points. Teď je třeba vybrat společné body (u vrstvy, co chceme georeferncovat a u vrstvy, ke které se budou body vztahovat; v našem případě současná ortofoto mapa) u kterých máme jistotu, že nezměnily svojí polohu (mohou to být například rohy budov či jiné bodové prvky). Pokud jsme takové body nalezli, tak již jen střídavě klikáním (nejprv na vrstvu kterou chceme georeferencovat a následně na druhou zmiňovanou vrstvu) na vybrané shodné body určujeme novou pozici LMS. Po propojení alespoň přes 3 body (v lepším případě však více), můžeme georeferncování uložit: Georeferencing → Update Georeferencing. 
Jelikož některé LMS mapují podstatně velký prostor, je třeba georeferncovat pouze tu část, na které budeme pracovat. Pokud, ale i přes to, nesedí LMS přesně tak, jak by měly, je třeba georeferencovat po ještě menších částech a tak, jak bude následná editace probíhat, tak i aktualizovat georeferencování. 
Nyní máme připravené všechny podklady pro vytvoření naší polygonové vrstvy představující využití krajiny a můžeme začít editovat. Lištu Editor aktivujeme postupem: View → Toolbars →Editors. V okně Target zvolíme vrstvu, kterou chceme editovat. Poté v menu Editor, kliknutím myši na Start Editing, začneme editovat. Jelikož máme připravený celý polygon obce, zbývá již jen postupné rozřezávání na jednotlivé typy využití krajiny. K tomu nám slouží nástroj Cut Polygons Tool v liště editoru. Editace se ukládá postupem: Editor → Save Your Edits a ukončuje přes: Editor → Stop Editing.
Vytvořeným polygonům je třeba přiřazovat hodnoty, které nám budou udávat typ využití. A také je třeba spočítat jejich rozlohu. Opět klikneme pravým tlačítkem na vrstvu v Table Of Contents a vybereme možnost Open Attribute Table. Postupem: Table Options → Add Field se objeví dialogové okno, zadáme název Plocha a klikneme ok. Stejně tak přidáme i sloupec, kam budeme zapisovat informace o typu využití půdy.
Zadávání hodnot do atributové tabulky je zcela prosté. Na liště editoru klikneme na ikonku Attributes a objeví se nám okno s hodnotami pro vybraný polygon. Zde už jen napíšeme o jaký typ využití se jedná (doporučuji pro rychlou a přehlednou práci používat číselná označení).
Pro spočítání rozlohy polygonů stačí opět otevřít atributovou tabulku, kliknout pravým tlačítkem na sloupec s rozlohou a vybrat možnost Calculate Geometry. Nastavíme jednotky, jaké je třeba, a potvrdíme přes ok. 
Posledním krokem je vytvoření mapových výstupů. Přes View → Layout View se dostaneme k náhledu na tisknutou oblast. V náhledovém okně umístíme vytvořenou mapu a přidáme legendu (Insert → Legend), kde si k jednotlivým mapám vybereme ty kategorie, které chceme vyobrazit na mapě. Poté vložíme nadpis (Insert → Title). Dále pak měřítko (Insert → Scale Bar). V nastavení je potřeba změnit jednotku Miles na jednotku Meters (případně Kilometers či jinou) a v řádku Label nastavit zkratku pro danou jednotku délky. Posledním přidaným prvkem je směrová růžice (Insert → North Arrow). Po umístění všech prvků do náhledového okna, můžeme mapu vyexportovat (File → Export map), zadáme kvalitu tisku a vybereme místo uložení a klikneme na uložit.

3.5 Klasifikační klíč využívání země

Při řešení problematiky mapování krajinné struktury a forem využití půdy je třeba si rozčlenit krajinu do několika klasifikačních skupin. Tyto skupiny reprezentují jednotlivé formy využívání krajiny na daném území.
Tabulka 1 - Kategorie ploch využití krajiny ve studovaném území

	1.
	vodní plochy

	2.
	orná půda

	3.
	trvalé travní porosty (TTP)

	4.
	zahrada, sad

	5.
	les

	6.
	zastavěná plocha

	7.
	ostatní plochy (silnice, cesty aj.)


Tabulka 1 představuje vlastní vytvořený klasifikační klíč. V porovnání s klasifikačním klíčem dle VÚKOZ byly odebrány ty skupiny, které neměly na daném území zastoupení. Na druhou stranu byla přidána jedna skupina, která reprezentuje ostatní plochy včetně silnic a cest. 

Tabulka 2 - Kategorie využití ploch dle VÚKOZ

	1.
	orná půda

	2.
	TTP

	3.
	zahrady a sady mimo intravilán

	4.
	vinice a chmelnice mimo intravilán

	5.
	lesy

	6.
	vodní plochy

	7.
	venkovská zástavba

	8.
	městská zástavba

	9.
	rekreační plochy

	10.
	státní plochy a objekty mimo intravilán obce


4 Charakteristika zájmového území 
4.1 Vymezení zájmového území

Obec Stružinec se nachází v Libereckém kraji, okrese Semily. Město Semily je zároveň obcí s rozšířenou působností, pod kterou Stružinec spadá. Obec je tvořena čtyřmi  katastrálními územími (Stružinec, Pohoří, Tuhaň, Bezděčín). K 31. 12. 2018 žilo v obci 709 obyvatel. Rozloha obce činí 11,21 km2 (ČSÚ, 2018).

„Kdy byl Stružinec založen, není bezpečně známo. Poloha podél potoka a rozložení polních tratí nasvědčují původu za doby kolonizace za posledních Přemyslovců. Byl-li Jiří ze Stružince, uváděný roku 1377 v soudní knize Jičínské, zemanem na stružinecké tvrzi nebo rychtářem poddanské vsi, snad jednou  historie zjistí“ (URL2).

Obec Stružinec leží v teréním zářezu Stružineckého potoka. Potok pramení v jižní části obce a teče směrem na sever, kde se přibližně kilometr za hranicí obce vlévá do říčky Olešky, terá se o pár kilometrů dále, v Semilech, vlévá do Jizery.

Nejvyšším bodem na území obce je vrch Vrchy (583 m n. m.). Naopak nejnižším je pak oblast, kde již zmíněný Stružinecký potok opouští území obce (přibližně 370 m n. m.). 
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Obrázek 1 - Poloha obce Stružinec v okrese Semily a jeho dílčí administrativní členění (2019)
Zdroj: ArcČR500 (2019) – upraveno, vlastní zpracování


Obec Mříčná se nachází v okrese Semily, kraji Libereckém. Obec je samosprávná a spadá pod správní obvod obce s rozšířenou působností Jilemnice. Město Jilemnice se nachází 4 km východně od obce. V současnosti žije v obci 578 obyvatel (k 31.12. 2018) a celková rozloha zájmového území, respektive rozloha obce, činí 10,04 km2 (ČSÚ, 2018). 
První písemná zmínka o obci se datuje do roku 1356. První písemný doklad však pochází z roku 1352, kde se v církevních zápisech Jičínského děkanátu objevuje doklad o obci Mříčná s farou a kostelem sv. Kateřiny (URL3).

„Obec patřívala vlastnicky i poddansky k Jilemnici a Štěpanici a tedy pánům, kteří právě Jilemnici vlastnili. Vlastníky byli Markvartici, poté Valdštejnové, pánové z Pecky, Křínečtí a posledními vlastníky byl rod Harrachů do roku 1918“ (URL3). 
Obec Mříčná leží v údolí potoka Olšina, který se později vlévá do Jizery. Nejvyšším bodem na území obce je zároveň i její nejvýchodnější bod. Na svahu vrchu Strážník v přibližné výšce 530 m n. m. Nejnižším bodem pak místo, kde Olšina opouští území obce (přibližně 390 m n. m.).
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Obrázek 2 - Poloha obce Mříčná v okrese Semily a jeho dílčí administrativní členění (2019)
Zdroj: ArcČR500 (2019) – upraveno, vlastní zpracování

4.2 Geologie
Obě vybrané obce leží v paleozoiku Českého masivu. V jednotce Podkrkonošské pánve. Obec Stružinec ještě svou nemalou částí, na západě území, zasahuje do oblasti prekambrických a paleozoických vulkanitů a metavulkanitů (PROUZA, 2007). 
Horniny které v této oblasti nalezneme představují rudé a šedé kalovce (prachovité jílovce), pískovce, arkózy či slepence. V západní části Stružince pak můžeme narazit na bazalty, bazalitické andesity a jejich alkalické ekvivalenty a tufy, navýš anchimetamorfované (PROUZA, 2007). 

4.3 Geomorfologie 

Obec Mříčná spadá do okrsku Lomnické pahorkatiny. Do stejného okrsku spadá i přibližně polovina území obce Stružinec. Zbytek území obce pak leží v okrsku Táborského hřbetu, který spadá pod Ještědsko-kozákovský hřbet
Tabulka 3 - Geomorfologické členění území obce Mříčná a Stružinec (2019)

	systém
	Hecynský

	provincie
	Česká vysočina

	subprovincie
	Krkonošsko-jesenická soustava

	oblast
	Krkonošská oblast

	celek
	Krkonošské podhůří
	Ještědsko-kozákovský hřbet

	podcelek
	krkonošská pahorkatina
	Kozákovský hřbet


	okrsek
	Lomnická vrchovina
	Táborský Hřbet


Zdroj: Balatka, B., Kalvoda, J. (2006)

Nejlépe charakterizují reliéf obce Mříčné a Stružince DEMEK, J., MACKOVČIN, P. (2006): „Lomnická vrchovina je plochá kerná vrchovina tvořená prachovci, pískovci, arkózami, slepenci a melafyry permské červené jaloviny, vzácně karbonského stefanu; charakterizovaná strukturně denudačním reliéfem destruovaných kuest, nesouměrných hřbetů a suků na melafyrových příkrovech, intruzích a ložních žilách, místy se uplatňuje plochý reliéf mírně ukloněných svahů a plošných zarovnaných povrchů; území rozčleňují široce rozevřená hluboká (místy asymetrická) údolí pravoúhlé vodní sítě v povodí Jizery.“

Autoři DEMEK, J., MACKOVČIN, P. (2006) dále uvádějí, že se jedná o krajinu středně zalesněnou. Nalezneme zde smrkové porosty a ojediněle porosty borové. 
4.4 Obyvatelstvo
V obou zájmových obcích je obyvatelstvo rozložené velmi nerovnoměrně. Zalidněnéjsou zejména oblasti podél Stružineckého potoka, respektive Olšiny. 

V obci Mříčná je současná celková nezaměstnanost (k 31.12.2018, ČSÚ) 3,66 %. Průměrný věk občánů v Mříčné je lehce nad 40 let (ČSÚ 2019). 


Průměrný věk obyvatel v obci Stružinec je 44 let (ČSÚ, 2019). Nezaměstnanost je k 31.12. 2018 (ČSÚ) necelých 2,7 %. 

Mnohem zajímavější informace však představuje tabulka 4. Zeleně jsou v této tabulce označeny hodnoty, které představují nejvyšší hodnoty za sledované období. Červeně jsou pak hodnoty nejnižší. Z tabulky tedy vyplývá, že nejvyšší počet obyvatel zaznamenala obec Mříčná při sčítání v roce 1890, to zde žilo na 1480 obyvatel. Avšak i přes to zde v této době stálo o více jak 30 domů méně než v současné době. 

Zde je ještě na snadě zmínit onen propasný úbytek obyvatel mezi lety 1930 – 1950. jednalo se o odsunutí sudetských Němců. Z tabulky je patrné, že v tomto období přišla obec Mříčná o de facto polovinu svých obyvatel. Obec Stružinec, ležící nepatrně dále směrem od hranice s Německem, tak razantní úbytek obyvatel nezaznamenala. 

Tabulka 4 - Vývoj počtu obyvatel a domů v obci Mříčná a Stružinec mezi lety 1869 - 2018

	 
	počet obyvatel
	počet domů

	rok sčítání
	Mříčná
	Stružinec
	Mříčná
	Stružinec

	1869
	1413
	1407
	178
	244

	1880
	1433
	1362
	187
	253

	1890
	1480
	1382
	198
	243

	1900
	1401
	1351
	196
	247

	1910
	1392
	1377
	202
	245

	1921
	1146
	1249
	200
	246

	1930
	1048
	1300
	204
	264

	1950
	588
	1001
	201
	271

	1961
	591
	1017
	182
	264

	1970
	495
	922
	163
	252

	1980
	486
	836
	149
	233

	1991
	448
	740
	212
	292

	2001
	474
	692
	223
	302

	2011
	505
	679
	231
	314

	2018
	578
	709
	-
	-


Zdroj: ČSÚ (2019)
5 Literární přehled
5.1 Pojem krajina

„Smyčka nekonečné zpětné vazby:
minulá činnost vytvořila současnou strukturu:
současná struktura vytváří současnou činnost;
současná činnost vytváří budoucí strukturu.“
(cit. FORMAN, R. T. T., GODRON, M., 1993).

Pojem krajiny si každý člověk vykládá trošku jinak, avšak obecně se má za to, že je to prostor kolem nás. Prostor, který nás obklopuje a jehož jsme my sami součástí. Krajina může člověka, stejně tak jako on ji, ovlivňovat. Avšak různé vědní disciplíny a jejich hlavní představitelé, definují krajinu odlišněji.
Například FORMAN a GODRON (1993) definují krajinu jako ekologicky heterogenní část zemského povrchu, skládající se ze souboru vzájemně se ovlivňujících ekosystémů, který se v dané části povrchu v podobných formách opakuje. Zároveň uvádějí, že rozsah krajiny je většinou několik kilometrů v průměru a větší.
Podobnou definici uvádí i DEMEK (1974), který definuje krajinu jako reálně existující část povrchu planety, která tvoří celek kvalitativně se odlišující od ostatních částí krajinné sféry. Má své přirozené hranice, svérázný vzhled, individuální vnitřní strukturu, určité fungování a specifický vývoj v čase. 
Pokud bychom se chtěli na pojem krajiny podívat srozumitelnějším pohledem, viděli bychom ji jako část zemského povrchu, která má svoje hranice a která se skládá z jednotlivých ekosystémů, jenž jsou ovlivňovány jednak vnitřní interakcí tak i člověkem.

5.2 Struktura Krajiny


„Struktura krajiny představuje prostorové vztahy mezi zastoupenými charakteristickými ekosystémy či složkami. Přesněji, rozložení energie, látek a druhů organizmů ve vztahu k velikosti, tvaru, počtu, druhu a prostorovému uspořádání ekosystémů“ (FORMAN, GODRON, 1993).


Podle MIKLÓS a IZAKOVIČOVÁ (1997) dělíme strukturu krajiny podle její geneze, fyzického charakteru a vztahu k využívání krajiny člověkem na 3 subsystémy:

· primární (prvotní, původní) struktura krajiny,

· sekundární (druhotná, současná) struktura krajiny,

· terciární (socioekonomická) struktura krajiny.

MIKLÓS a IZAKOVIČOVÁ (1997) dále na různých úrovních krajinného systému rozlišují prostorovou krajinnou strukturu vertikální a horizontální. 
5.2.1 Primární krajinná struktura

Struktura krajiny primární nebo také přírodní je základem pro rozvoj dalších typů krajinných struktur. MIKLÓS, L. IZAKOVIČOVÁ Z. (1997) uvádějí, že primární struktura krajiny představuje soubor prvků a složek krajiny a jejich vztahů, které člověk změnil jen relativně velmi málo. Řadí sem například geologický podklad, reliéf či vodstvo.
5.2.2 Sekundární krajinná struktura

Sekundární krajinná struktura  představuje viditelnou povrchovou část, tvořící bezprostředně hmotné prvky prostředí života člověka i velkého množství organizmů (MIKLÓS, L., IZAKOVIČOVÁ Z., 1997). Vzniká na podkladě primární struktury krajiny dlouhodobým působením člověka a jeho hospodářské činnosti (LÖW, J., MÍCHAL, I., 2003).

Sekundární krajinná struktura je dále složena z povrchových prvků – land cover (krajinná pokrývka), které ve funkčních souvislostech poznáme jako land use (využívání země). V druhotné struktuře krajiny můžeme rozlišit současnou krajinnou strukturu a historickou krajinnou strukturu (BEDRNA, Z., MIKLÓS, L., IZAKOVIČOVÁ, Z., 1992).

5.2.3 Terciární krajinná struktura

Terciární krajinnou strukturu tvoří prvky a složky socioekonomické sféry. Tyto prvky a složky souvisejí s činností člověka v krajině. Jedná se o soubor nehmotných prvků a jevů, které se váží na hmotné prvky a mají prostorový projev - jsou „mapovatelné“ v prostoru (MIKLÓS, L., IZAKOVIČOVÁ, Z., 1997).

5.2.4 Prostorová krajinná struktura

5.2.4.1  Vertikální prostorová krajinná struktura

„Struktura vertikální je dána geomorfologií, výškovou členitostí terénu. Je výsledkem přírodních vlivů. Taková krajina je tedy tvořena tzv. krajinnými složkami (klima, voda, půda, přirozená vegetace) (URL4).“

5.2.4.2 Horizontální prostorová krajinná struktura

FORMAN, R. T. T., GODRON, M. (1993) dále dělí horizontální prostorovou krajinnou strukturu na 3 základní skladebné součásti:

· plošky,
· matrice,
· koridory. 

· Plošky

Základním kamenem horizontální struktury krajiny jsou povrchy (plošky). „Plošku lze vymezit jako tu plošnou část povrchu, která se vzhledem liší od svého okolí. Plošky se různí co do své velikosti, tvaru, typu, heterogenity i vlastních hranic“ (cit. FORMAN, R. T. T., GODRON, M., 1993).
· Matrice

Matrice je plošně převládající, nejvíce zastoupený a zároveň prostorově nejpropojenější typ krajinné složky, který hraje dominantní roli ve fungování krajiny (tj. tok energie, informací a organismů) (LIPSKÝ, 1998).
· Koridory

Koridory dle FORMAN, R. T. T., GODRON, M. (1993) představují liniové prvky území, které mohou tvořit jen izolované pásy, ale obvykle navazují na plošku s podobnou vegetací. Koridorem se můžou rozumět přirozené struktury (např. Vodní tok), ale i člověkem vytvořené nepůvodní prvky (např. živý plot, silnice

5.2.5 Časová struktura krajiny

Změny v krajinné struktuře můžeme sledovat v různých časových horizontech. Mění se de facto z minuty na minutu, během dne, roku či delšího časového úseku. Časová struktura krajiny je podřízena hlavně rytmikou krajinotvorných pochodů a jimi navozovaných stavů krajiny (DEMEK, J., 1999).

6 Vývoj krajiny v ČR od poloviny 20. století


Od poloviny 20. století prodělala struktura zemědělské krajiny razantní změny. Příčinou byla největší měrou změna vlastnických poměrů a přechod k velkovýrobě. V první fázi (období tzv. kolektivizace) došlo k razantnímu, často až nevratnému rozorávání mezí, polních cest, remízků apod. a scelování pozemků do velkých lánů, tím se zvětšila eroze půdy. (LIPSKÝ, Z., 2000). 

Zavedení mechanizace od 70. let minulého století v lesním hospodářství vedlo k opětovné preferenci holosečí a zvyšování podílu jehličnanů. Období 70. až 80. let 20. století je také charakterizováno výraznými imisními škodami na porostech (NĚMEC, J., POJER, F. et al., 2007). 

Patrně druhá nejnegativnější fáze pro krajinu, její ekologickou stálost a biodiverzitu probíhala v 70. letech 20. století, kdy došlo na pozemkové úpravy, které razantně změnily tvář zemědělské kulturní krajiny. Byly rozorány poslední zbytky stabilizačních rozptýlených prvků v krajině (remízky, meze), došlo k odvodnění, trvalé travní porosty a nivy byly rozorány (LIPSKÝ, Z., 2000; LÖW, J., MÍCHAL, I., 2003). 

Dramatická homogenizace a fragmentace krajiny spolu s dodatkovou energií 39 v podobě vysokých dávek průmyslových hnojiv a pesticidů se staly hlavními příčinami vyvrcholení ekologické destabilizace a estetické degradace české krajiny ve 20. století (NĚMEC, J., POJER, F. et al., 2007). 

Po roce 1989 nastává období v němž se stále více prosazují přírodě blízké způsoby lesního hospodaření. Pozvolna se zvyšují podíly listnatých dřevin v lesích. Dochází k postupnému zvyšování lesnatosti, což můžeme z krajinotvorného hlediska vnímat velmi pozitivně (NĚMEC, J., POJER, F. et al., 2007). V současné době si začínáme uvědomovat, jak špatný vliv měla kolektivizace a jiné procesy ve 20. století na českou kulturní krajinu. Pozvolna se snažíme vracet krajině její původní tvář. Horské a podhorské neúrodné oblasti (mezi které bychom mohli zařadit i naše dvě obce) jsou zalesňovány, dochází k nárůstu trvale travních porostů, opuštěné zemědělsky nevyužívané plochy (louky, pastviny i pole) jsou postupně zarůstány křovinnou a stromovou vegetací, a to vše díky změně hospodářského prostředí (restituce půdy, pronájem státní půdy). Celkově se zvyšuje i ekologická stabilita krajiny, její druhová rozmanitost a dochází ke snižování objemu a obsahu chemických prostředků v půdě a krajině (LIPSKÝ, Z., KVAPIL, D., 2000).

7 Vývoj využití krajiny v zájmových územích



Na základě leteckých měřických snímků (LMS) a ortofoto map byly vytvořeny následující mapy a grafy, které znázorňují zastoupení jednotlivých typů využití krajiny v obcích Mříčná a Stružinec na Semilsku. Dokáží tak lépe nastínit jak se vyvíjela krajina v podkrkonoší od poloviny 20. století až do současnosti. 
7.1 1947

· Stružinec
Prvním sledovaným rokem byl rok 1947. Z grafu 1 vyplývá, že největší zastoupení měla v krajině, obce Stružinec, orná půda. Zde je třeba říci, že z LMS byla zcela patrná odlišná zemědělská činnost, než na jakou jsme zvyklí ze současnosti. Poměrně malé souvislé plochy orné půdy protkané napříč loukami a pastvinami. Orná půda přesto v tomto roce v obci Stružinec představovala necelých 40 % z celkové rozlohy obce. 




Druhé největší zastoupení měly v tomto roce trvalé travní porosty (TTP). Představovaly více jak 31 % z celkové rozlohy obce Stružince. Třetí největší podíl (20,49 %) představují lesy, následovány zahradami společně se sedy (5,54 %). Zbylé přibližně 3 % představují zastavěné plochy, vodní plochy a ostatní plochy. 
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Obrázek 3 - Relativní zastoupení využití krajiny v obci Stružinec v roce 1947 (%)

Z obrázku 3 vyplývá rozložení jednotlivých typů využití krajiny na území obce Stružince v roce 1947. Zřetelně je vidět zejmená členitost jednotlivých ploch. Dále je vidět celá škála jednotlivých cest, kterými je celá oblast protkána. 
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Obrázek 4 - Mapa využití krajiny v obci Stružinec v roce 1947
Zdroj: LMS (1947) – upraveno, ArcČR500 (2019) - upraveno
· Mříčná
V obci Mříčná, stejně tak jako ve Stružinci, měly v roce 1947 největší podíl zastoupení orné plochy. Celkový podíl orných ploch činil 36,65 % z celkové rozlohy (10,04 km2) obce, což představuje bezmála 368 ha. 

Situace v mříčné byla podobná jako ve Stružinci, alespoň co se týče velikosti jednotlivých ploch. Celé území bylo totiž rovněž složeno z menších políček a sečných luk. To vše bylo protkáno nespočetným množstvím cest. 

Druhé největší zastoupení (29,22 %) měly TTP. 3. největší zastoupení představovaly lesy, které zaujímaly rozlohu více jak 27 % rozlohy obce. To je o více než 7 % více než v obci Stružinec v temtýž roce. 
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Obrázek 5 - Relativní zastoupení využití krajiny v obci Mříčná v roce 1947 (%)
Na obrázku 6 můžeme vidět rozsáhlejší lesnaté plochy. Dále zde můžeme vidět, že na celém území obce Mříčná se nenachází ani jeden průmyslový či zemědělský areál. V neposlední řadě můžeme vidět, stejně tak jako u obce Stružinec, menší velikosti jednotlivých plošek.
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Obrázek 6 - Mapa využití krajiny v obci Mříčná v roce 1947 

Zdroj: LMS (1947) – upraveno, ArcČR500 (2019) - upraveno

7.2 1957/1958
Jelikož v roce 1957 neprobíhalo snímkování obce Stružinec, byly jako alternativa vybrány snímky z roku 1958. 
· Stružinec
V roce 1958 nastává v obci Stružinec nepatrná změna. Byl zde zaznamenán nárust TTP na 36,4 %. Trvalé travní porosty tak v tomto roce zaujímaly největší část rozlohy obce ze všech typů využívání krajiny. Pokud porovnáme obrázek 4 a obrázek 8, můžeme vidět, transformaci některých ploch orné půdy právě na zmíněné TTP. Čím byla tato změna způsobena lze jen těžko odhadnout.
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Obrázek 7 - Relativní zastoupení využití krajiny v obci Stružinec v roce 1958 (%)
Lesy představovaly stále přibližnou pětinu rozlohy obce. A jejich poloha se oproti roku 1947 de facto nezměnila. Nepatrný nárůst byl zaznamenán také u zastavěných ploch a ostatních ploch (cest, silnic, aj.)
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Obrázek 8 - Mapa využití krajiny v obci Stružinec v roce 1958
 Zdroj: LMS (1958) – upraveno, ArcČR500 (2019) - upraveno

· Mříčná
Více jak třetinu (35,9 %) zaujímaly v roce 1957 v obci Mříčná orné půdy. Stejně tak jako v roce 1947 tvořily největší část rozlohy obce. Druhé největší zastoupení měly TTP (30 %) a lesy (více jak 27 %). 
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Obrázek 9 - Relativní zastoupení využití krajiny v obci Mříčná v roce 1957 (%)
Z obrázku 10 je stále patrné, že v obci Mříčná se v roce 1957 nenacházel ani jeden průmyslový areál. Tato podkrkonošská obec si tak stále držela vzhled  čistě zemědělské obce. 
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Obrázek 10 - Mapa využití krajiny v obci Mříčná v roce 1957
Zdroj: LMS (1957) – upraveno, ArcČR500 (2019) – upraveno
7.3 1977

· Stružinec

Opětovný nárust podílu orné půdy na celkově rozloze obce Stružinec. V roce 1977 jsme zaznamenali podíl orné půdy bezmála 40 %. Druhé největší zastoupení měly opět TTP (30,8 %). Lesní plochy se opět takřka nezměnily a zaujímaly plochu 20 % celkové rozlohy obce.
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Obrázek 11 - Relativní zastoupení využití krajiny v obci Stružinec v roce 1977 (%)
Na obrázku 12 můžeme sledovat rozrůstající se zemědělská družstva (např. v de facto samotném centru obce). Mezi lety 1958 – 1977 byl zaznamenán nárůst zastavěných ploch o 16 desetin procenta na 0,83 % z celkové rozlohy obce. 

Malé zemědělské plochy jsou slučovány do větších a větších celků. Cesty či meze jsou rozorávány případně transformovány na sečné louky. 
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Obrázek 12 - Mapa využití krajiny v obci Stružinec v roce 1977
Zdroj: LMS (1977) – upraveno, ArcČR500 (2019) - upraveno
· Mříčná
Ani obci Mříčná se nevyhnula kolektivizace. A tak stejně jako u Stružince jsou malé orné plochy slučované do větších. Můžeme si povšimnout výstavby dvou zemědělských areálů v severní a jižní čísti obce. I tento fakt přispěl ke zvýšení zastavěné plochy o 0,12 % z celkové rozlohy obce. 
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Obrázek 13 - Relativní zastoupení využití krajiny v obci Mříčná v roce 1977 (%)
Zastoupení jednotlivých složek využití půdy však zůstalo oproti předchozímu sledovanému období takřka nezměněné. Obrázek 13 nám znázorňuje opět přibližně třetinové zastoupení orné půdy, TTP a lesních porostů. 
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Obrázek 14 - Mapa využití krajiny v obci Mříčná v roce 1977
Zdroj: LMS (1977) – upraveno, ArcČR500 (2019) - upraveno
7.4 1989
· Stružinec

I v roce 1989 zaujímaly v obci Stružinec orné půdy největší rozlohu. Celkově tvořily více jak 38 % z celkové rozlohy obce. Následovaly TTP, které tvořily bez mála 32 %. 
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Obrázek 15 - Relativní zastoupení využití krajiny v obci Stružinec v roce 1989 (%)
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Obrázek 16 - Mapa využití krajiny v obci Stružinec v roce 1989
Zdroj: LMS (1989) – upraveno, ArcČR500 (2019) - upraveno
· Mříčná 
V roce 1989 představovaly orné půdy v obci Mříčná 35 % celkové rozlohy obce. V tomto roce už jako druhé největší zastoupení představovaly lesy (29 %). 
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Obrázek 17 - Relativní zastoupení využití krajiny v obci Mříčná v roce 1989 (%)
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Obrázek 18 - Mapa využití krajiny v obci Mříčná v roce 1989
Zdroj: LMS (1958) – upraveno, ArcČR500 (2019) - upraveno
7.5 2007 
· Stružinec 

V roce 2007 byla krajina ve Stružinci tvořena ze 39 % ornými půdami, z necelých 31 % TTP a z více jak 20 % lesními porosty. Více než 5 % tvořily zahrady a sady. Zastavěná plocha stoupla již na 0,84 % z celkové rozlohy obce.
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Obrázek 19 - Relativní zastoupení využití krajiny v obci Stružinec v roce 2007 (%)
[image: image22.jpg]



Obrázek 20 - Mapa využití krajiny v obci Stružinec v roce 2007
Zdroj: CUZK (2019) – upraveno, ArcČR500 (2019) - upraveno
· Mříčná 
V roce 2007 tvořily TTP v obci Mříčná opět více než 30 % celkové rozlohy. O něco více (33 %) rozlohy zaujímaly orné půdy. 
V obci postupně příbývaly nové budovy, a tak v roce 2007 tvořily zastavěné plochy 0,61 % celkové rozlohy obce.
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Obrázek 21 - Relativní zastoupení využití krajiny v obci Mříčná v roce 2007 (%)
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Obrázek 22 - Mapa využití krajiny v obci Mříčná v roce 2007
Zdroj: CUZK (2019) – upraveno, ArcČR500 (2019) - upraveno
7.6 2018

· Stružinec

 
Současná podoba krajiny ve Stružinci je, stejně tak jako v předchozích sledovaných letech, tvořena z největší části ornou půdou (takřka 38 %). Druhý největší podíl z celkové rozlohy obce tvoří TTP (32 %). Lesy v současné době představují přibližně pětinu z celkové rozlohy obce.
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Obrázek 23 - Relativní zastoupení využití krajiny v obci Stružinec v roce 2018 (%)
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Obrázek 24 - Mapa využití krajiny v obci Stružinec v roce 2018
Zdroj: CUZK (2019) – upraveno, ArcČR500 (2019) - upraveno
· Mříčná
Současná podoba obce Mříčná je tvořena z největší části ornou půdou (32 %). Přibližně stejně velký podíl pak zastávají TTP (30 %) a lesy (29 %). Necelých 5 % pak představují zahrady a sady.
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Obrázek 25 - Relativní zastoupení využití krajiny v obci Mříčná v roce 2018 (%)
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Obrázek 26 - Mapa využití krajiny v obci mříčná v roce 2018
Zdroj: CUZK (2019) – upraveno, ArcČR500 (2019) - upraveno
8 Porovnání využití krajiny v zájmových územích
Jelikož máme nyní všechna potřebná data, můžeme kriticky zhodnotit, zda-li se obce

Mříčná a Stružinec od druhé poloviny 20. století vyvíjeli jinak či nikoliv. 

Tabulky 5 a 6 nám představují relativní i absulutní hodnoty využití krajiny za celé sledované období v našich zájmových územích. 

Tabulka 5 - Vývoj využití krajiny v obci Stružinec od roku 1947 do současnosti

	 
	rok

	
	1947
	1958
	1977
	1989
	2007
	2018

	
	plocha

	typ plochy
	ha
	%
	ha
	%
	ha
	%
	ha
	%
	ha
	%
	ha
	%

	orná půda
	440,141
	39,25
	381,877
	34,06
	445,901
	39,77
	431,776
	38,51
	441,399
	39,37
	422,445
	37,68

	TTP
	354,341
	31,60
	408,106
	36,40
	345,301
	30,80
	356,280
	31,77
	345,681
	30,83
	363,138
	32,39

	zahrada, sad
	62,124
	5,54
	63,180
	5,63
	62,230
	5,55
	62,228
	5,55
	61,666
	5,50
	62,830
	5,60

	les
	229,739
	20,49
	230,054
	20,52
	225,730
	20,13
	228,303
	20,36
	230,458
	20,55
	230,458
	20,55

	zastavěná plocha
	6,611
	0,59
	7,480
	0,67
	9,257
	0,83
	9,394
	0,84
	9,433
	0,84
	9,597
	0,86

	vodní plocha
	0,299
	0,03
	0,299
	0,03
	0,997
	0,09
	0,997
	0,09
	0,997
	0,09
	0,997
	0,09

	ostatní plochy
	28,014
	2,50
	30,273
	2,70
	31,853
	2,84
	32,292
	2,88
	31,636
	2,82
	31,805
	2,84


Tabulka 6 - Vývoj využití krajiny v obci nříčná od roku 1947 do současnosti

	 
	rok

	
	1947
	1957
	1977
	1989
	2007
	2018

	
	plocha

	typ plochy
	ha
	%
	ha
	%
	ha
	%
	ha
	%
	ha
	%
	ha
	%

	orná půda
	367,927
	36,65
	360,423
	35,90
	339,788
	33,85
	351,885
	35,05
	330,887
	32,96
	328,380
	32,71

	TTP
	293,321
	29,22
	301,368
	30,02
	301,761
	30,06
	285,692
	28,46
	304,173
	30,30
	304,614
	30,34

	zahrada, sad
	33,979
	3,38
	33,604
	3,35
	40,830
	4,07
	42,238
	4,21
	45,379
	4,52
	47,261
	4,71

	les
	276,817
	27,57
	276,841
	27,58
	289,578
	28,84
	291,632
	29,05
	290,509
	28,94
	290,490
	28,93

	zastavěná plocha
	4,588
	0,46
	4,625
	0,46
	5,788
	0,58
	5,948
	0,59
	6,160
	0,61
	6,349
	0,63

	vodní plocha
	0,921
	0,09
	0,921
	0,09
	1,750
	0,17
	2,126
	0,21
	2,126
	0,21
	2,126
	0,21

	ostatní plochy
	26,390
	2,63
	26,162
	2,61
	24,448
	2,44
	24,423
	2,43
	24,709
	2,46
	24,724
	2,46


Na obrázku 27 můžeme sledovat vývoj relativního zastoupení orné půdy. Je patrné, že podíl orné půdy na celkové rozloze obcí je jak v Mříčné tak ve Stružinci podobný. Od poloviny 20. století se u obou obcí pohybuje orná půda v rozmezí 30 – 40 % z jejich celkové rozlohy. Ani u jedné obce jsme po celou dobu sledování nezaznamenali výraznější změnu.
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Obrázek 27 - Vývoj relativního zastoupení orné půdy na území obcí Mříčná a Stružinec
Zastoupení TTP se stejně tak jako u orné půdy vyvíjelo de facto stejně. Jedinou výjimkou byl rok 1958, kdy se relativní zastoupení TTP na celkové rozloze obce dostalo nad 35 %. Po celou dobu sledování se tak v obci Mříčná i v obci Stružinec vyskytují TTP na přibližně 1/3 celkové rozlohy. V obci Mříčná to v současné době představuje necelých 300 ha. V Obci Stružinec v současné době TTP zabírají rozlohu více jak 350 ha.
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Obrázek 28 - Vývoj relativního zastoupení TTP na území obcí Mříčná a Stružinec

Lesní plochy se v obou obcích vyvíjely takřka stejně. V obci Mříčná byl zaznamenaný nepatrný nárůst
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Obrázek 29 - Vývoj relativního zastoupení lesních ploch na území obcí Mříčná a Stružinec
Patrně nejstabylnější složkou krajiny v obci Stružinec byly zahrady a sady. Jejich podíl na celkové rozloze obce se takřka po celou dobu sledování neměnil. V obci Mříčná jsme naopak zaznamenali nepatrný nárůst těchto ploch.
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Obrázek 30 - Vývoj relativního zastoupení zahrad a sadů na území obcí Mříčná a Stružinec
Nepatrně větší podíl zastavěných ploch na celkové rozloze můžeme pozorovat v obci Stružinec. Obě obce zaznamenaly největší nárůst zastavěných ploch mezi lety 1957 – 1977. Bylo to způsobeno již zmíněnou výstavbou nových zemědělských areálů na území obcí. 
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Obrázek 31 - Vývoj relativního zastoupení zastavěných ploch na území obcí Mříčná a Stružinec
Nepatrně větší zastoupení vodních ploch nalezneme na území Stružince. Vodní plochy však nepředstavují nikterak velké zastoupení v celkové rozloze obou obcí. 
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Obrázek 32 - Vývoj relativního zastoupení vodních ploch na území obcí Mříčná a Stružinec
Vývoj podílu ostatních ploch na celkové rozloze obce se vyvíjel v obou obcích trošu jinak. V obci stružinec byl zaznamenán postupný (ne však příliš razantní) nárůst těchto ploch. Bylo to způsobeno zejména výstavbou nových zemědělských areálů. 
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Obrázek 33 - Vývoj relativního zastoupení ostatních ploch na území obcí Mříčná a Stružinec
9 Závěr
Krajina je všude kolem nás a člověk je hlavní fragment, který jí ovlivňuje. Je právě jen na nás jakým způsobem se o ni budeme starat, pečovat o ni a jak ji budeme měnit. 

Postupem času si lidé stále více uvědomují, že o krajinu je skutečně třeba pečovat. Že několikahektarové lány polí, které člověk tvoří za účelem co největšího zisku jsou vlastně pro něj ztrátou. 

Tato bakalářská práce měla za cíl vytvořit přehled změn v krajině na území obcí Mříčná a Stružinec. Podkladem pro tuto práci byly jednak letecké měřické snímky, tak i ortofoto snímky. Z těchto mapových podkladů byly následně, pomocí georeferencování, vytvořeny základní vrstvy pro práci v ArcGis.

Největší zastoupení v obou zájmových oblastech představují orné půdy. V současné době tvoří v obci Mříčná 367 ha a v obci Stručinec dokonce hektarů 440. Orné plochy prodělaly od poloviny 20. století celou řadu změn. Ta největší proběhla v 70. letech, kdy proběhla tzv. kolektivizace. Jednotlivá malá políčka se sjednocovala do větších. Tyto rozlehlé lány pak dávaly, a mnohde stále dávají, prostor pro erozní procesy.
Druhé největší zastoupení mají v obou oblastech trvalé travní porosty. Ty představují v obou obcích přibližně 30 % celkové rozlohy. Lesní plochy v obou obcích stále de facto stagnují. Po celou dobu sledování se takřka nezměnily a bohužel v tomto ohledu nekopírují trend z jíných částí republiky, kde se naopak člověk snaží navracet lesní porosty do krajiny a nahrazovat tak jimi například již zmíněné rozsáhlé erozí zničené lány polí. 

Na konec lze konstatovat, že krajina obou obcí se od poloviny 20. století vyvíjela takřka stejně. Nebyly zaznamenány nějaké razantnější rozdíly ve využití krajiny. 
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11 Seznam použitých zkratek 
· VÚKOZ – Výzkumný ústav pro krajinu a okrasné zahradnictví

· ČSÚ – Český statistický úřad

· ČÚZK – Český úřad zeměměřičský a katastrální

· LMS – letecké měřické snímky

· GIS – geografické informační systémy/geoinformační systémy

· např. – například
· aj. – a jiné

· tzv. – tak zvaně
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